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NT Audit Guide

General Information

The security provided through Windows NT combined with regular use of the Backup utility, should help to eliminate most of the possibilities of data loss.  Security in Windows NT consists of two basic elements:


- Preventing data loss resulting from unauthorized access


- Preventing data loss resulting from file damage

For most actions related to security,  you must be a member of the Administrator group.
When you use Windows NT File Server, it logs all file transactions, replaces bad sectors automatically, and stores copies of all vital information.  Therefore, Windows NT can preserve disk integrity and ensure complete, rapid recovery after power failure or other system failures.

No matter which files system you use, Windows NT also automatically preserves a previous working configuration to ensure that you can always start Windows NT, in spite of any changes to the system configuration that may occur during a work session.  Windows NT also requires that you create an Emergency Repair disk while running Setup so that your system can be repaired if system files are corrupted at startup.
I. Password Control
1.  Windows NT is a secure system and you must identify yourself and log-on each time you start

     Windows NT.

2.  In the welcome dialog box enter your username and password.  You must also enter your server name or

    a Windows NT Advanced Server domain name.

3.  The Username box is the name you entered while running Setup to identify your local user account, or it 

     is the domain username assigned by the system administrator.  Each time you log-on, Windows NT 

     proposes the username for whoever last logged on at this computer.

4.  The entry in the Password box is the one you defined while running Setup or that the system

     administrator defined for you.  This box  could be left blank if the user has not been assigned a password.

5.  Press CRTL+ALT+DEL to change your password, to lock or secure the computer, or to log-off.  You can

     also choose Logoff from the File menu in Program Manager, or ALT+F4.

6.  To turn off your computer choose Shutdown from the File menu in Program Manager.  Be sure to 

     Shutdown your computer when you quit, so Windows NT can save changes in all working files and 

     properly close applications and services.

7.  In Windows NT a workgroup is a collection of computers that appear under the same workgroup name

     on the network.  This capability can also be set up in a Server domain.  Membership in a domain is

     assigned by the domain administrator in a Windows NT Advanced Server network.

8.  Managing the Account Policy.  Review the Account Policy controls to ensure proper password controls

     are being used.  All users must comply with the Account Policy.  From the Policy menu under User 

     Manager choose Account.  In the Account Policy dialog box, there are four password parameters:


- Maximum Password Age


- Minimum Password Age


- Minimum Password Length


- Password Uniqueness

     Review these parameters to ensure that they are adequately defined.

II. Remote Access Service
1.  To log-on to a domain from a remote workstation


a. Log on to your computer


b. Start the Remote Access Service


c. Connect to the network


d. From the File menu in Program Manger, choose Logoff


e. Choose the OK button


f. Press CTRL+ALT+DEL to log-on


g. In the Welcome dialog box, type your domain username and password, and also select the


    domain name in the From box


h. Type your password and then choose the OK button

2.  To turn off domain browsing


a. From the Main group, start File Manager


b. From the Disk menu, choose Connect Network Drive


c. From the Connect Network Drive dialog box, clear the Expand By Default box


d. Choose the OK button 

III. Setting Up Startup Applications

1.  You can specify which applications will start automatically whenever you log-on.  These changes will

     only be saved for your user account.  If another user  logs-on to your computer or if you log on to 

     another account, the startup applications defined for that account will appear.

2.  To define startup applications open Startup group in Program Manager and add a program item for

     each application that you want to start each time you log-on.

3.  If your computer is a member of a Windows NT Advanced Server domain, the system administrator 

     should have created a user profile for each user.  This profile will override any user defined profile.

IV. Configuring the Network 

1.  Windows NT provides network services so that users can connect computers to share files, printers,

     and other resources.  To install, configure, or remove any network component and to join a workgroup

     domain, you must be logged no as a member of the Administrators group.

2.  Use Network in Control Panel


To install and configure software to support the network, and to join workgroups or domains

3.  Use Event Viewer


To view the system, security, and application events on a computer to monitor how the computer


is being used.  The Event Viewer also defines the size and management of the security event log.

4.  Use File Manager


To share files and directories on the network, and connect to shared directories.  File Manager


also defines the files, directories, and users to be audited.  Finally, File Manager can be used to


establish permissions to protect specific files and directories.


To display the names of directories and files along with size, last modification date and time,


and attributes of files in the contents list, from the View menu choose All File Details.


File Manager allows you to see version information for files.  This information supplied by the


manufacturer of an application including the company name and other comments.  To obtain this

  
information, select the file whose information you want to see.  From the File menu choose 


Properties.  In the Version Information box, select the file in the left box.  The information on the


file is displayed in the right box.

5.  Use Print Manager


To share printers on the network, and connect to shared printers.  The Print Manager also defines


printers to be audited.

6.  Use Server in Control Panel


To View connected users, shared resources, and opened resources; manage directory replication


and designate recipients of administrative alerts.


List each of the services and review to ensure that only authorized services are offered.

7.  Use Services in Control Panel


To start and stop network services.  This can be setup to run automatically.

8.  Use User Manager


To manage user accounts, group members, and security policies.  Defines the kinds of events


to be audited.  User Manager also authorizes specific actions a user can perform on the system.

9.  The networks, domains and workgroups, computers, and shared directories are organized in a tree

     structure.  From the Shared Directories box, choose an item to expand the list.  Choose a network

     name to display available domains and worksgroups, a domain or workgroup name to display 

     available computers, or a computer name to display its shared directories.

V. Managing and Securing Directories and Files 

Windows NT supports the following three file systems:


- The Windows NT file system (NTFS)



File and directory names can be up to 256 character.  It is not case sensitive and it



maintains a MS-DOS name for compatibility.


- The file allocation table (FAT)


- The high performance file system (HPFS)


You can control users’ access to directories and files on drives formatted to use the Windows NT file system (NTFS).  Drives formatted to use FAT and HPFS do not support Windows NT security.  You can, however, secure shared directories no matter what file system is in use.

To secure a directory of file, set permissions on it.  Each permission you set specifies the access that a group or user can have to the directory of file. 

 The standard permissions for directories are:


- No Access


- List


- Read


- Add


- Add & Read


- Change


- Full Control

The standard permissions for a file are:


- No Access


- Read


- Change


- Full Control

The standard permissions are groups of individual permissions.  When you set a standard permission, the abbreviations for the individual permissions are displayed beside the standard permission.  These individual permissions can be define for a custom set of permissions for a directory or a file for a user.  These individual permissions are:


- Read (R)


- Write (W)


- Execute (X)


- Delete (D)


- Change Permissions (P)


- Take Ownership (O)

Permissions are cumulative except that the No Access permission overrides all other permissions.  When you create files and subdirectories in a directory, they inherit permissions from the directory.   The user that creates a file or a directory is the owner of that file or directory.  Users who are members of the Administrators group can always take ownership of a file or directory.  The best way to establish security is to use group control.

In some cases, directory permissions for a group or user are not passed on to subdirectories.  This occurs, for example, when a group or user has been granted permissions through the CREATOR OWNER special group.  Permissions that will not be inherited by subdirectories are marked with an asterisk.

When you set standard permissions, two sets of individual permissions are displayed next to it.  The permissions set on the directory and the permissions set on files in the directory.  For example, when you set Add & Read permissions on a directory, you see (RWX), signifying Read, Write, and Execute permissions on the directory, and (RX), signifying Read and Execute permission on files in the directory.

Some directory permissions set file permissions to Not Specified.  When access to files for a user or group is not specified, that group or user cannot use files in the directory unless access is granted by another means.

CREATOR OWNER is a special group to allow users to control only the subdirectories and files that they create within the directory.  Permissions set on CREATOR OWNER are transferred only to the user who creates a directory or file within the directory.

To view or change directory permissions


- Select the directory in the directory window of File Manager.  You can select multiple directories.


- From the Security menu, choose Permissions.  Or choose the Permissions button on the toolbar.


- The name box shows the groups and users for whom permissions have been set on the file.


- To change permissions on a file you must be the owner of the file or have been granted 


   permission to do so by the owner.

1.  Review the use of directory Replication.  Directory replication is the duplication of a master set of 

     directories from a server (called an export server) to specified servers or workstations (called import

     computers) in the same or other domains.  A windows NT workstation can only be set up as an 

     import computer.

     Before replication can occur, a special user account must be created, configured, and assigned to

     the Replicator service.

     To determine if replication is being used, in the Control Panel window choose the Server icon.

     In the Server dialog box, choose the Replication button. All replicated directories will be listed.

     Review the list to ensure that any sensitive or critical directories are properly protected.

VI. Operating System Variables

1.  You can specify the default operating system that your system proposes at startup, define user

     environment variables, and add or configure virtual-memory paging files to optimize performance

     in Windows NT.

2. To configure boot loader, user environment variables, or virtual memory


Use the System option of Control Panel, to review the specific settings


The boot loader defines the information needed for system startup, such as the location for


the operating system’s files.  Windows NT automatically creates the correct configuration and 


checks this information whenever the system is started.  The startup preferences are usually 


stored in the BOOT.INI file.  Configuration files such as AUTOEXEC.BAT and CONFIG.SYS 


are used only to specify memory and other parameters for MS-DOS based applications that


might run under Windows NT.

VII. User Accounts and Groups

A user account consist of all information that Windows NT uses to allow someone to use a computer, including the username, a description, a password, and the groups to which that user belongs.

A group is an account that contains other accounts, which are called members.  Groups provide an easy way to grant common capabilities to several users, because all rights and permissions assigned to a group are provided to its members.

1. To set up a user account and group for a single user.


a. In Administrative Tools group in Program Manager use the User Manager icon.


b. Create the user accounts needed.


c. Create the groups needed.

2.  Windows NT provides personal groups and common groups.  Personal groups are stored as part of each

     user’s log-on information.  Each time a particular user logs on, that user’s personal groups appear.  

     Common groups appear for all users who log-on to the computer. Personal and common groups have

     different icons.  To create common groups you must be logged on as a member of the Administrators

     or Power Users group.

     When you install Windows NT, the system created groups and program items for applications are:


a. Main



Contains the Windows NT system applications including File Manager, Control Panel,



and Print Manager.  


b. Applications



 Contains applications found on the users hard disk.


c. Administrative Tools



Contains applications for system management including User Manager, Disk 



Administration, and Backup.


d. Accessories



Includes applications for word processing, drawing, and communications, plus 



several other applications such as a clock and a calculator.


e. Games



Offers games you can use to practice Windows skills


f. Startup



Contains applications that start when a user logs-on to Windows NT.  Any application



can be added to this group.  It is empty until applications are added.

3.  Administrators - A user who is logged on to a user account that is a member of the Administrators

     group can perform all User Manager functions.  List all of the members of this group and determine

     if each user requires this level of authority.

4.  Power Users -  A user who is logged on to a user account that is a member of the Power Users group

     can use User Manager to create user accounts and groups, and to modify or delete those user

     accounts and groups.  A Power User can also add and remove users from the Power Users, Users, and

     Guests groups.  List all of the members of the Power Users group and determine if these users require 

     this level of authority.

5   Users - A user who is logged on to a user account that is a member of the Users group can use User 

     Manager to create groups, can modify or delete those groups, and can give any user account

     membership in those groups.  List all of the members of the Users group and determine if these users

     require this level of authority.

6.  Guest - A built-in account that can be renamed but not deleted.  Guest is install without a password.  

     Review Guest authority to ensure that critical or sensitive directories or files are not available to this

     user.

7.  User Accounts - List all user and group accounts to ensure that only authorized users our able to 

     log-on to the system.  

8.  User Rights - Rights apply to the system as a whole, and are different from permissions, which apply to 

     specific objects.  A permission is a rule associated with an object (usually a directory, file or printer) to 

     regulate which users can have access to the object and in what manner.  Most often the creator or owner 

     of the object sets the permissions for the object.

     Rights are not associated with a specific object.  Instead, a right applies to the entire system, and

     may override permissions set on an object.  Review all user rights and advanced user rights to ensure

     that only required users have special privileges.  To obtain user rights, use Policy menu under User 

     Manager. Choose User Rights.  Select a right and the users and groups that have those rights will be

     displayed.

9.  Each user account when added has several password options.  These include:


- User Must Change Password At Next Log-on


- User Cannot Change Password


- Password Never Expires


- Account Disabled

10. User Log-on Scripts -  Log-on scripts are optional.  If a logo script is assigned to a user account, it

      runs automatically every time the user logs-on.  Review any log-on scripts by using the User Manager,

      User Environment Profile dialog box.

VIII.  Screen Savers

When Windows NT is set up, a default screen saver is selected.  When you use a screen saver provided by Windows NT, you can ensure that unauthorized users do not have access to your work by using password protection with a screen saver.  If someone tries to use your computer once the password protected screen saver is displayed, a Lock Workstation dialog box appears.  To unlock the computer, the same password used to log-on to the computer must be entered.

To select a screen saver and run password protection on:

1. Under Screen Saver in the Desktop dialog box, select a screen saver in the Names box.

2. In the Delay box, click the up or down arrow to increase or decrease the number of minutes before the 

    screen saver is activated, or type a number between 1 and 99.

3. To protect you display with a password, select the Password Protect check box.

 IX DEVICE SECURITY

List all defined devices on the Windows NT operating system.

1. In the Control Panel window choose the Device icon.

2. In the Devices dialog box the status of the devices is displayed.  Review the list to ensure that all 

    devices are properly authorized.

X. Backup and Recovery

1. Determine if an Uninterruptible Power Supply is connected to the Windows NT environment.


- Go to the Control Panel and select UPS

2. Review the configuration parameters for the UPS to ensure that they are properly set.


- Does the UPS device send a signal if the regular power supply fails


- Does the UPS device send a warning when battery power is low.


- Does the UPS service send a signal telling the UPS device to shut off.


- Is there a command file to execute at shutdown time.


- Is the battery life expectancy and recharge time adequate.

3.  Is the UPS system tested on a periodic bases?

4.  Ensure that backups are taken on a periodic bases and store off-site in a protected environment.

XI. Security Alerts

The Alerts dialog box displays and manages the list of users and computers that are notified when administrative alerts occur.  For alerts to be sent, the Alerter and Messenger services must be running on the computer originating the alert.  For alerts to be received, the Messenger service must be running on the destination computer.

1. In the Control Panel window choose the Server icon.

2. In the Server dialog box choose the Alerts button

3.  Review the list of users that are notified when an alert occurs.

XII. Audit/Security Guideline

1.  Obtain a list of all the Administrators and determine that each user with this capability needs list level of

     authority.

2.  Obtain a list of all users and groups and ensure that each member is a valid entry.

3.  Determine that default account rules are set to ensure that all users must properly log-on to the system.

4.  Determine that the default password rules are set to industry standards.

5.  Determine if domains or workgroups are being used.  If they are, map each user or group to a domain

     and ensure that each user requires this level of access.

6.  Determine which common user groups have been established and review the groups capability to 

     ensure that all users need to have this level of access.

7.  Determine what personal groups have been established for each user and ensure that the user needs

     this level of access to perform their job function.

8.  Map all the startup applications for each user to ensure that only authorized applications are accessed.

9.  Review all system services to ensure that users are restricted to authorized functions only

10. Obtain a listing of all directories subdirectories, and files.

11. Review the permission levels of who owns the directories, subdirectories, and files.

12. Review all user and group privileges to critical or sensitive directories, subdirectories, or files.

13. Obtain a list of all of the user’s rights and determine if the user needs this level of authority.

14. Review the Power User group and ensure that only authorized individuals are members of this group.

15. Review the User group and ensure that only authorized individuals are members of this group.

16. Review the Guest group and ensure that this group’s authorities are restricted.

17. Review the user’s Log-on Script to ensure that it is set up properly from a security perspective.

18. Review the system’s configuration files and ensure that the parameters are properly set.

19. Determine if screen saver security is properly set.

20. Review all devices and the security settings protecting access to these devices.

21. Determine what alerts are established to notify the security administrator of any security violations.

22. Determine if any directory replication has been established and ensure that sensitive or critical data is

      properly protected on the remote platform.

23. Review the event auditing for the system and determine if it is adequate.

24. Review the backup procedures for contingency planning to ensure that they are adequate.

25. Review the organizational structure to ensure that there is a proper separation of duties.
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